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FCC INFORMATION

This equipment generates, uses and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause harmful
interference to radio communication. Operation of this equipment in a residential area
is likely to cause harmful interference in witch case the user will be required to correct
the interference at his own expense.

Federal Communication Commission Interference Statement

This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference in a residential installation.
This equipment generates, uses and can radiate radio frequency energy and, if not
installed and used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct the
interference by one of the following measures:

@ Reorient or relocate the receiving antenna.

@ Increase the separation between the equipment and receiver.

e Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

e Consult the dealer or an experienced radio/TV technician for help.

This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) This device may not cause harmful interference, and (2)
this device must accept any interference received, including interference that may
cause undesired operation.

This module is intended for OEM integrator. The OEM integrator is responsible for
the compliance to all the rules that apply to the product into which this certified RF
module is integrated. Additional testing and certification may be necessary when
multiple are used. Any changes or modifications not expressly approved by the
manufacturer could void the user's authority to operate this equipment.
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USERS MANUAL OF THE END PRODUCT

In the users manual of the end product, the end user has to be informed to keep at
least 20cm separation with the antenna while this end product is installed and
operated. The end user has to be informed that the FCC radio-frequency exposure
guidelines for an uncontrolled environment can be satisfied. The end user has to also
be informed that any changes or modifications not expressly approved by the
manufacturer could void the user's authority to operate this equipment. If the size of
the end product is smaller than 8x10cm, then additional FCC part 15.19 statement is
required to be available in the users manual: This device complies with Part 15 of
FCC rules. Operation is subject to the following two conditions: (1) this device may
not cause harmful interference and (2) this device must accept any interference
received, including interference that may cause undesired operation.

The final end product must be labeled in a visible area with the following " Contains
TX FCC ID: XPQAMWZ5168CL ". If the size of the end product is larger than 8x10cm,
then the following FCC part 15.19 statement has to also be available on the label:
This device complies with Part 15 of FCC rules. Operation is subject to the following
two conditions: (1) this device may not cause harmful interference and (2) this device
must accept any interference received, including interference that may cause
undesired operation.

FCC Radiation Exposure Statement:

This equipment complies with FCC radiation exposure limits set forth for an
uncontrolled environment. This equipment should be installed and operated with
minimum distance 20cm between the radiator & your body.
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1 GENERAL INFORMATION

The AMWZ5168-CL module is a range of ultra low power, high performance
surface mount modules targeted at IEEE 802.15.4, JenNet-IP, ZigBee Light Link,
ZigBee Smart Energy and RF4CE networking applications, enabling users to realise
products with minimum time to market and at the lowest cost. They remove the need
for expensive and lengthy development of custom RF board designs and test suites.
The modules use NXP’s JN5168 wireless microcontroller to provide a comprehensive
solution with large memory, high CPU and radio performance and all RF components
included. All that is required to develop and manufacture wireless control or sensing
products is to connect a power supply and peripherals such as switches, actuators
and sensors, considerably simplifying product development.
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FEATURES

GENERAL

Low-cost RF SOC module

Few external component count

Compact size and low power consumption
High reliability

Custom-made

2.0V ~ 3.6V power supply

Industrial temp (-40°C to +85C)

Lead-free and RoHS compliant

RF / ANALOG

ISM band 2.405~2.475 GHz operation

IEEE 802.15.4 specification compliance

Receiver sensitivity -96 dBm

Tx output power +3.41dBm

Differential Antenna input/output

Low current consumption: 17.5 mA in RX and 15 mA in TX mode
High receiver and RSSI dynamic range

Offset QPSK modulation (DSSS baseband)

uFl connector 16x21mm

Up to 1km range (Ext antenna)

MICROCONTROLLER

32-bit RISC CPU, up to 32MIPs with low power
Data EEPROM with guaranteed 100k write operations
RF4CE, JenNet-IP, Zighee Smart Energy stacks
JTAG debug interface

4-input 10-bit ADC, 1 comparator

5 x PWM (4 x timer, 1 x timer/counter)

2 UARTs

SPI Master & Slave port with 3 selects

2-wire serial interface

Battery and Temperature Sensor

Watchdog timer and BOR

Up to 20 DIO
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ELECTRICAL SPECIFICATION

Table 2. Electrical Specification of AMWZ5168-CL module VDD =3.0V @+25C

Typical DC Characteristics Notes
Deep Sleep Current 100nA
Sleep Current 0.70uA With active sleep timer
Radio Transmit Current 15mA CPU is doze, radio transmitting
Radio Receive Current 17.5mA CPU is doze, radio receiving
Centre Frequency accuracy +/-25ppm Additional +/-15ppm allowance for temperature and ageing
Typical RF Characteristics Notes
Receive Sensitivity -96dBm Normal for 1% PER, as per 802.15.4 section 6.5.3.3
Transmit Power +3.41dBm Normal
Maximum Input signal +10dBm For 1% PER, measured as sensitivity
RSSI range -95to -10 dBm
RF Port Impedance —uFL connector 50 ohm 2.4 —2.5GHz
Rx Spurious Emissions -61dBm Measured conducted into 50 ohms
Tx Spurious Emissions -40dBm Measured conducted into 50 ohms
VSWR (max) 2:1 2.4 —2.5GHz
Peripherals Notes
Master SPI Port 3 selects 250kHz — 16MHz
Slave SPI Port Yes 250kHz — 8MHz
UART 2 16550 compatible
Two-wire sglr\l/lzﬂLll/SFgEclgrg)patlble with Yes Up to 400KHz
5 x PWM (4 x timer, 1 x timer/counter) yes 16MHz clock
Programmable Sleep Timers 2 32kHz clock
Digital IO_Iines (multiplexed with 20
UARTS, timers and SPI selects)
Analogue-to-Digital converter 4 Channels 10-bit, up to 100ks/s
Programmable analogue comparators Yes Ultra low power mode for sleep
Internal Temperature_Sensor and Yes
Battery Monitor

3.1 MAXIMUM RATINGS
Parameter Min Max
Device Supply Voltage VDD -0.3V 3.6V
All Pins -0.3V VDD + 0.3V
Storage Temperature -40°C +150C
3.2 OPERATING CONDITIONS
Supply Min Max
VDD 2.0V 3.6V
Ambient temperature range -40°C +85°C
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4  INSTALLING CDM DRIVERS

This user manual provides guidance on installing and setting up the tool on PC.
CDM driver provides access to both virtual COM port (VCP) and FTDI’s proprietary
“direct” (D2XX) interfaces, it should install before connect a PC to main board using a
USB-to-serial cable. Hyper terminal access the new connection between PC and
AMWZ5168 module and is used for selecting appropriate operation mode for
AMWZ5168 module on PC screen.

4.1 INSTALLING VIA THE FOUND NEW HARDWARE WIZARD

To install CDM drivers for an FTDI device under Windows XP, please follow the

instructions below:

> If a device of the same type has been installed on your machine before and the
drivers that are about to be installed are different from those installed already,
the original drivers need to be uninstalled. Please refer to the Uninstalling CDM
Drivers section of this document for further details of this procedure.

» Download the latest available CDM drivers from the FTDI web site and unzip
them to a location on your PC.

» If you are running Windows XP or Windows XP SP 1, temporarily disconnect
your PC from the Internet. This can be done by either removing the network
cable from your PC or by disabling your network card by going to the "Control
Panel\Network and Dial-Up Connections", right-clicking on the appropriate
connection and selecting "Disable" from the menu. The connection can be re-
enabled after the installation is complete. This is not necessary under Windows
XP SP 2 if configured to ask before connecting to Windows Update. Windows XP
SP 2 can have the settings for Windows Update changed through "Control
Panel\System" then select the "Hardware" tab and click "Windows Update".

» Connect the device to a spare USB port on your PC. If the device is based on
the FT2232, the Microsoft composite device driver is automatically loaded in the
background. Once the composite driver has been installed Windows Found New
Hardware Wizard will launch. If there is no available Internet connection or
Windows XP SP 2 is configured to ask before connecting to Windows Update,
the screen shown in Figure 2.1 is displayed. Select "No, not this time" from the
options available and then click "Next" to proceed with the installation. If there is
an available Internet connection, Windows XP will silently connect to the
Windows Update website and install any suitable driver it finds for the device in
preference to the driver manually selected.

Copyright © 2013 Aptos Technology Inc.



Aptos

Technology

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard

Windows will search for curent and updated software by
looking on your computer, on the hardware installation CD, or on
the Windows Update Web site [with your permission).

Online privacy information

Can Windows connect to Windows Update to search for
software?

Click Next to continue

l [ Cancel

—_—
1=
1]
=

Figure 2.1

» Select "Install from a list or specific location (Advanced)" as shown in Figure 2.2
below and then click “Next".

Found New Hardware Wizard

This wizard helps you install software for:

IJSE Senal Converter

* ) If your hardware came with an installation CD
iz or floppy disk. insert it now.

What do you want the wizard to do?

(O Install the software automatically (Recommended)

(& Install from a list or specific location [Advanced]

Click Next to continue

I < Back ” MNext > l[ Cancel

Figure 2.2
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» Select "Search for the best driver in these locations" and enter the file path in the
combo-box ("C:\CDM 2.02.04" in Figure 2.3 below) or browse to it by clicking the
browse button. Once the file path has been entered in the box, click next to
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proceed.

Found New Hardware Wizard

Please choose your search and installation options.

(®) Search for the best driver in these locations.

paths and removable media. The best driver found will be installed.

[ search remavable media (floppy, CO-ROM...)

Include this lacation in the search:

(O Don't search. | will choose the driver to install

the driver you choose will be the best match for your hardware

CACDM 2.02.04 v | Browse

=

lUse the check boxes below to limit or expand the default search, which includes local

Choose this option to select the device driver from a list. Windows does not guarantee that

I < Back H Next > II Cancel

Figure 2.3

If Windows XP is configured to warn when unsigned (non-WHQL certified)
drivers are about to be installed, the message dialogue shown in Figure 2.4 will
be displayed unless installing a Microsoft WHQL certified driver. Click on
"Continue Anyway" to continue with the installation. If Windows XP is configured

to ignore file signature warnings, no message will appear.
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Hardware Installation

L "_\ The zoftware pou are installing for this hardware:
L)
IISE Senial Corveerter

haz not pazzed Windows Logo testing to venfy it compatibility with
thiz verzion of Windows, [Tel me why this testing iz important)

Continuing your installation of this software may impair
or destabilize the comrect operation of pour spstem
either immediately or in the future. Microzoft strongly
recommends that you stop thiz installation now and
contact the hardware vendor for software that has
pazsed Windows Logo testing.

[ Continue Anyway ] EéTDPInstallatiDn J

Figure 2.4

The screen shown in Figure 2.5 will be displayed as Windows XP copies the
required driver files. Windows should then display a message indicating that the
installation was successful. Click "Finish" to complete the installation for the first
port of the device.

Found New Hardware Wizard

Please wait while the wizard installs the software. .. \\

N,

E USE Sernial Converter

74

ftd2we dll
To C:AWINDOWShsystem32

Figure 2.5
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If the device is based on the FT2232, the Found New Hardware Wizard will
continue by installing the USB Serial Converter driver for the second port of the
FT2232 device. The procedure for installing the second port is identical to that
for installing the first port from the first screen of the Found New Hardware
Wizard. This is done automatically if the driver is Microsoft WHQL certified. If the
device is not based on the FT2232, the COM port emulation driver is loaded as
indicated in the following steps.

The Found New Hardware Wizard will launch automatically to install the COM
port emulation drivers. As above, select "No, not this time" From the options and
click "Next" to proceed with the installation (Figure 2.6).

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard

Windows will search for current and updated software by
looking on your computer, on the hardware installation CD, or on
the Windows Update Web site [with your permission)

Online privacy information

Can ‘Windows connect to Windows Update to search for
software?
(O Yes, this time only

(O Yes, now and every time | connect a device

Click Nest to continue

[ Next > ][ Cancel

Figure 2.6

» Select "Install from a list or specific location (Advanced)" as shown in Figure 2.7

below and then click "Next".
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Found New Hardware Wizard

This wizard helps you install software for:

IUSE Senal Port

* ) If your hardware came with an installation CD
i or floppy disk, insert it now.

What do you want the wizard to do?

O Install the software automatically (Recommended)

(& Install from a list or specific location [Advanced]

Click Next to continue

I < Back ‘[ Next > ][ Cancel

Figure 2.7

» Select "Search for the best driver in these locations" and enter the file path in the
combo-box ("C:\CDM 2.02.04" in figure 2.8 below) or browse to it by clicking the

browse button. Once the file path has been entered in the box, click next to
proceed.
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Found New Hardware Wizard

Please choose your search and installation options.

&

(®)Search for the best driver in these locations .

lUse the check boxes below to limit or expand the default search, which includes local
paths and removable media. The best driver found will be installed.

[ 5earch remavable media (floppy, CO-ROM...)

Include this location in the search:

C:ACDM 2.02.04 v

(O Don't search. | will choose the driver to install

Choose this option to select the device driver from a list. Windows does not guarantee that
the driver you choose will be the best match for your hardware.

I < Back ][ MNext > II Cancel

Figure 2.8

» If Windows XP is configured to warn when unsigned (non-WHQL certified)
drivers are about to be installed, the message dialogue shown in Figure 2.9 will
be displayed unless installing a Microsoft WHQL certified driver. Click on
"Continue Anyway" to continue with the installation. If Windows XP is configured
to ignore file signature warnings, no message will appear. The screen will be
displayed as Windows XP copies the required driver files. Windows should then
display a message indicating that the installation was successful. Click "Finish"
to complete the installation for the first port of the device.
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Hardware Installation

" "_\ The zoftware pou are installing for this hardware:
L]
I1SE Senial Port

haz not pazzed Windows Logo testing to venfy it compatibility with
thiz verzion of Windows, [Tel me why this testing iz important)

Continuing your installation of this software may impair
or destabilize the comrect operation of pour spstem
either immediately or in the future. Microzoft strongly
recommends that you stop thiz installation now and
contact the hardware vendor for software that has
pazsed Windows Logo testing.

[ Continue Anyway ] E.mﬁTDF'InstallatiDn J

Figure 2.9

If the device is based on the FT2232, the second port must also be installed. The
procedure for installing the second port is identical to that for installing the first
port from the first screen of the Found New Hardware Wizard for the USB Serial
Port device. If the driver is Microsoft WHQL certified, this is done automatically.

Open the Device Manager (located in "Control Panel\System" then select the
"Hardware" tab and click "Device Manger") and select "View > Devices by
Connection", the device appears as a "USB Serial Converter" with an additional
COM port with the label "USB Serial Port" (Figure 2.10). If the device is based on
the FT2232, two ports will be available from a composite USB device.
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Device Manager
Fil=  Action  Wiew Help
g %
*§ ACPI Fixed Feature Button ~
% Genuine Inkel(R) CPU 2160 @ 1.80GHz
% Genuine Inkel(R) CPU 2160 @ 1.80GHz
= i PCIbus
o] |§ Intel{R) F46GZ Express Chipset Family
- i Intel(R) 2801 PCI Bridge - 244E
¢ Intel(R) 82801G (ICH7 Family) SMBus Contraller - 27008
Intel{R) 52501 (ICHT Family) USE Universal Host Controller - 27Ca
+ Inkel{R) 82801 (ICHT Family) USE Universal Host Controller - 27CE
Inkel(R) 52801 (ICHT Family) USEZ Enhanced Host Controller - 27CC =
; Inkel(R) 82801GE/GR (ICH? Family) LPC Interface Controller - 2763
[+ =) Intel(R) 52501 GE/GR,fiGH (ICHF Family) Serial ATa Storage Contraller - 2700
= -_J Intel{R) 94E6GZ/PLIGL PCI Express Rook Port - 2971
: _J Intel{R) 945GZ PLIGL Processar ta [JO Controller - 2970
3 _J Micrasoft UAA Bus Driver For High Definition Audio
i g Maotherboard resources w

Figure 2.10

In the case of the FT2232, port A of the FT2232 will be installed as COMX and
port B will be installed as COMX+1 where COMX is the first available COM port
number.

% Device Manager

File  Action  Wiew  Help

- @M & 2m A

=l i PCIbus
[+ @ Intel{R) 946GZ Express Chipset Family
[+ i InkeliR) 62801 PCI Bridge - 244E
i Y Intel{R) G2801G (ICHT Family) SMEus Controller - 2704
1+ Intel{R) 52801 (ICHT Family) USE Universal Host Controller - 27Ca
5 Intel{R) 82801G (ICH7 Family) USE Universal Host Controller - 27C9
= Intel{R) 52801 (ICH7 Family) USE Universal Host Controller - 27CA

|

= |SE Composite Device
= é 1USE Serial Converter &
- % usB seridl Port (COM3)
= éﬁ' USE Serial Converter B
% UsE Serial Port (COM4)
TS apeiletet B Tniversal Host Controller - 27CE
Inkel{R) 52501 (ICHT Family) USEZ Enhanced Haost Controller - 27CC
¢ Inkel(R) 82801 GE/GR (ICH7 Family) LPC Interface Controller - 2765
|2 Intel(R) 52801GE/GR,/GH (ICHF Family) Serial ATA Storage Contraller - 2700
-j Inkel{R) 946G PLIGL PCI Express Rook Port - 2571
-j Intel{R) 946GZ PLIGL Processar ta [fO Controller - 2970
[+ -j Micrasoft UGS Bus Driver For High Definition Audio
: -j Motherboard resources

s W
|

%

Figure 2.11

Copyright © 2013 Aptos Technology Inc.



Aptos

Technology

5 APPLICATION
5.1 SETTING UP AND RUNNING THE TOOL

This section describes how to use the tool running on the AMWZ5168 module from a

PC. Operational instructions are provided below for those using Microsoft Hyper
Terminal to interface with the tool.

» Open HyperTerminal: Accessories > Communications > HyperTerminal.

» Access the New Connection dialogue box: File > New Connection. Type a name
for the connection, then click OK.

Connection Description ﬂﬂ

Enter a name and chooze an icon for the connection:

Hame:

I Cuztomer Module Ewvaluation T ool

lzar:

] I Cancel |

Figure 3.1

» Choose the serial communications port that the board is connected to and then
click OK.
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=7 Module Lab Test

Enter detailz for the phone number that yow want to dial;

Countrydregion: IUﬂitEd Fingdarn [44] j

Area code; IEI'I 14

Fhone number; I

Connect using:
Ok, I Cancel |

Figure 3.2

Set the port settings to 38400 bits per second, 8 data bits, no parity, 1 stop bit
and no flow control, then click OK.

Port Settings |
Bitz per second: |384DD j
Ciata bitg: IB ﬂ
Bairity: INone j
Stop bits: |1 j
Flow cantral:

Bestare Defaults |

0k I Cancel | Apply |
Figure 3.3

Access the Properties dialogue box: File > Properties. Click on the Settings tab
(shown below), ensure the box label Emulation is set to “Auto detect” and then
click OK.
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Conkect To  Settings |

 Function, arow, and cbrl keys act as
O 0 Windows keys

— Backspace key sendz
@& Chl+H ¢ Del & Chl+H, Space, Ciil+H

Emulation:

Auto detect j Tierminal Setup.. |

Telnet terminal ID: [&NS

Backscroll buffer lines: IEDD ::I

[~ Play sound when connecting or disconnecting

Input Translation. .. | ASCI Setup... |

(] I Carncel |
Figure 3.4

» Press any key, and the screen shown below will be generated by the board.

‘g Com2 - 38400 - HyperTerminal I =10 x|
Fle Edt Wiew Call Transfer Help

D& | & 3|05 | &

- Customer Module Evaluation Tool =
" Version 1.02 "
- Compiled Mar 11 2009 10:10:28 -
" Production Test API Version 0x00010018 =

D

a) Standard Module

b} Standard Module (Boost Mode - JN513x Only)
c) Standard Module (0dBm Mode - JNS148 Only)
d)} High Power Module

e) Telec Low Power Module

f)} Telec High Power Module

Please choose an option »_

K LF‘

Connecked 0:26:57 ANST 36400 8-N-1 Al UM € i

Figure 3.5
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